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Xilinx ISE hasznalata F2

A fejlesztokornyezet killonboz6 modokon hasznalhato
1. Lokalisan a szamitogépre telepitve: 1E226 és IE321

Az otthoni hasznalathoz sziikséges a telepitokészlet
letoltése ¢s ~12GB lemeztertilet

2. Virtualis gépen futtatva 1E413

3. A BME VIK kari felhoben https://cloud.bme.hu
Telepités €s lemezigeny nélkiili, de halozati kapcsolatot
igényel (VIK Cloud, KIFU-NIIF Cloud)

Bejelentkezés cimtaron keresztiil: Windows 10 ISE V2 VM

Hasznalat tavoli asztal kapcsolaton keresztiil vagy konzolban

4. KSZK SCHACcc tavoli hozzaférés RemoteApp
BME-MIT /\/\A
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Xilinx ISE

« Xilinx ISE: Osszetett tervezéi kornyezet, mi csak
n¢hany egyszeriibb szolgaltatasat hasznaljuk

& ISE Project Navigator (P.20131013) - DAXIlind\GYAK_3\GYAK 3xise - [BUS_MUX_4_4_13) - o
[2) File Edit View Project Source Process Tools Window Layout Help -8 x
D3EF %% IX|wa| i ALPBARLRAIAIZETSLRIPEL T
[Design «08x & 3 ~
ij | vew: © 1 impiementation O [ smuiston 5= 4
a1 [ i = s
] | Hierarchy :
&% @ 6vak3 = 7
—|=a xe3:250e-Stq144 8 |module BUS_MUX_4_4_1(
ob o KUELZO (KUELZO.) s imput T [15:0
= MPX - BUS MUX 4. 4.1 (BUS M 10 o f .
& EK - DEK 2.4 (DEK2.4v) 1 output reg [3:0] digit
a HEX_7SEG - HEX 7SEG (HEX 7S 4 | 15 ):
[l LOGSYS_SP3E.uct 0| 29
v |< > 14 always @(*)
Hd BET
P | €2 Mo Processes Running o | 16 digit <= num{ 3: 0
B MPX- > 17 digit <= num[ 7: 4
7L, | Processes: MPX - BUS_MUX_4.4_1 ‘ ) s Qigit <= num(11: 8]
U |9 @ Design Utilties o| 10 : digit <= num(15:12);
€ Create Schematic Symbol 20 endcase
4 [2)  View HOL Instantiation Temp... 21
—| 8 Checksyntax 22 endmodule
23
24 ™
. I (N K >
2 Sot O3 Dugn L) Fes () Lbares | & Design Summary B KuELZO. B BUS_MUX 4.4 Lv [x]
Console “08x
DLCompiler:1845 - Analyzing Verilog file "D:/Xilinx/GYAK_3/HEX_7SEG.v" into library work ~

Analyzing Verilog file " 3/KIJELZO.v" into library work
Analyzing Verilog file "D:/Xilinx/GYAK_3/KIJELZO_TF.v" into library work
ing design hierarchy completed successfully.

Analyzing Verilog file "D:/Xilinx/GYAK_3/BUS_MUX_4_4_l.v" into library work
Analyzing Verilog file "D:/Xilinx/GYAK 3/DEK_2_4.v" into library work
Analyzing Verilog file "D:/Xilinx/GYAK 3/HEX_75EG.v" into library work
Analyzing Verilog file "D:/Xilinx/GYAK_3/KIJELZO.v" into library work
INFO:ProjectMgmt - Parsing design hierarchy completed successfully.

Launching Design Summary/Report Viewer...

Xilinx/GYi

Started : "Launching ISE Text Editor to edit KIJELZO.v".

Started : "Launching ISE Text Editor to edit BUS_MUX_4_4_l.v".

< >
(6 consce @ Ermors A\ Wamings @8 Fndin Fies Resuts
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Projekt 1¢trehozasa (1)

* Xilinx ISE 14.7/6 elinditasa

Microsoft Office

‘ Microsoft Silverlight
National I
N ASZtal —_ Ikon u N:lk::na nstruments
ISEDesign OpenVPN feher
—_— Vagy el 1k :2:::’;2:!3\( Dokumentumok
RTLwvision PRO 59.7
Scope Képek
— Start — All Programs — shac

Skype

Total Commander

- XilinX Design TOOIS —_— Xilinx Design Tools

DocNav Szémitégép
ISE Design Suite 14.7

— ISE Design Suite 14.7 — e

Documentation Eszkoz0k és nyomtatok

. ., EDK
- ISE DeSIgn TOOIS _) ) ISE Design Tools Alapértelmezett programok
& 32-bit Project Navigator
& 64-bit Project Navigator

— 32/64-bit Project Navigator | e

Jatékok

SGgo és tdmogatés

64-bit Tools

BME-MIT /\/\A
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Projekt 1¢trehozasa (2)

Az uj projekt létrehozasa
File — New Project Pa——

Create New Project

Projekt neve: Labl et o

Enter a name, locations, and comment for the project

Helye pl. D:\DTLab\ | - =

Location: D:\DTLab\Lab1

Working Directory: | D:\DTLab\Lab1

Projekt tipusa: HDL | -

Select the type of top-level source for the project

Top-level source type:

HDL B

e ]

FPGA labor

Projekt 1¢trehozasa (3)

* Ami fontos: A fizikai alkatrész specifikalasa

— Family: Spartan3E
— Device: XC3S250E

» A feldolgozasi tech- s o
nolagia specifikalasa T —
— Synthesis tool: XST | s |

— Pref. lang: Verilog

BME-MIT /\/\A

A

Evaluation Development Board None Specified
Product Category All

Family Spartan3E

EEEIEEE]

Speed -4

Synthesis Tool XST (VHDL/Verilog)
Simulator ISim (VHDL/Verilog)

Property Specification in Project File  Store all values

(] EEE]E]

Manual Compile Order
VHDL Source Analysis Standard VHDL-93

Enable Messaqe Filtering

More Info | Next [ Cancel J

FPGA labor




Projekt létrehozasa (4)

Osszefoglalas a beallitasokrol

A Finish utan a
projekt struktura
létrejon

* Ezutan kovetkezik
a projekt forrasfajlok
elokészitése

@ & New Project Wizard

Project Summary

Project Navigator will create a new project with the following specifications.
Project:

Project Name: Labl

Project Path: D:\DTLab\Labl
Working Directory: D:\DTLab\Labl
Description:

Top Level Source Type: HDL

Device:

Device Family: Spartan3E
Device: Xc3s8250e
Package: tqgléd
Speed: -4

Top-Level Source Type: HDL

Synthesis Tool: XST (VHDL/Verilog)

Simulator: ISim (VHDL/Verilog)

Preferred Language: Verilog

Property Specification in Project File: Store all values
Manual Compile Order: false

VHDL Source Analysis Standard: VHDL-93

Message Filtering: disabled

More Info Finish Cancel ]

BME-MIT /\/v\
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Projekt forrasok létrehozasa (1)

A tervet a HDL forrasfajlok specifikaljak

— Project — New Source

— vagy a Design ablakban jobb gomb — New Source

& ISE Project Navigator (P.20131013) - D:\DTLab\Lab1\Lab1 xise

Empty View

"0 files. You can add files to the project using the

i = = sm the Project menu, and by using the Design,
02 ¥ (|l | » R E
i New Source...
Design «+08& X "
A= A
(7 | View: © {8} Implementation ©) [ Simulation il fidd Souce
o ] (1=
] | Hierarchy = ste a{ {z] Add Copy of Source...
& €] Labl ane Manual Compile Order
= £ xc3s250e-4tqldd E :Toc
3t Empty View » Implement Top Medule
The view currently contains no files. You can add files to the project using the od File/Path Display »
toolbar at left, commands from the Project menu, and by using the Design, =
. Files, and Libraries panels. Expand All
Use: Collapze All
*New Source: To create a new source file. {4 Eind... Ctrl+F
* Add Source: To add an existing file to the project.
* Add Copy of Source: To copy an existing file to the project directory v| Design Properties...

BME-MIT /\/\A
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Projekt forrasok létrehozasa (2)

« Az elso forrasfajl tipusa:

— Verilog Module

— F4jl neve: Labl 1

— (kiterjesztés .v)

— Helye: a projekt
konyvtar

— ' Add to project

BME-MIT /\/\A

& New Source Wizard

Select Source Type

Select source type, file name and its location.

{J IP (CORE Generator & Architecture Wizard)

(0] Schematic

|=] User Documen t

Verilog Module

A Verilog Test Fixture

(g VHDL Module

VHDL Library

[¢] VHDL Package File name
‘) VHDL Test Bench Lab1_1
g% Embedded Processor

Location:

D:\DTLab\Lab1

V| Add to project

More Info ‘

‘ Next ‘ Cancel \

FPGA labor

Projekt forrasok létrehozasa (3)

* Definialjuk a bemeneti és kimeneti jeleket

— Kapcsolok:

* sw 8db

* Input

* Bus v

« MSB7LSB0
— LED-ek

«Id 8db

e Output

* Bus v

« MSB7LSBO0

BME-MIT N&ehetne bitenkeénti megadas is (sw0, swl,..sw7)

@ & New Source Wizard

Define Module

Specify ports for module.
Module name |Lab1_1
Port Name Direction Bus
input E v 7
output E v 7
input E
input E]
input E
input E
input E
input E!
input 9
input E
input E]
input 9

More Info ]

==
MSB LSB
0
0
‘ Next ‘[ Cancel |

FPGA labor




Projekt forrasok letrehozasa (4)

« Osszefoglalas a beallitasokrol
* Finish utan létrejon a Labl_1.v Verilog HDL forrasfajl

* A Jhikon jelzi, hogy ez o pr— =
a projekt hierarchia Sumamary

csucsan lévo,
» 10p Module” forras fajl

Design
(71 | View: @ 18} Implementation ©) [ Simulation

e a new skeleton source with the following specifications.

7:0 input
7:0 output

[E| | Hierarchy

& & Labl
= = €3 xc3s250e-4tql44
[V)e% Labl1 (D:ADTLab\Labl\Labl 1.v)

&

 Minden mas projektfajl | ... e

ez ala fog rendezodni
BME-MIT

Cancel
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Projekt forrasok létrehozasa (5)

A Labl _1.v Verilog minta szovegfajl tartalma

— “timescale Ins/1ps: A szimulacid soran  ieeceie e/ s
az 1dofelbontas 1ps, az értékek ns-ban

ertendok 1,23456789us = 1234,568ns
— A (z0ld) megjegyzeés mez0 nem lényeges

— A Verilog f4j1 module ....endmodule
torzse tartalmazza az altalunk megadott
input output paramétereket, tovabba ide
keriil majd a forraskod lényeges, module Labl_i(

input [7:0] sw,

output [7:0] 1d

a mukodest specifikalo része, azaz a X
funkciot leird kodsorok (lasd késObb) — enamcaac

BME-MIT /\/\A
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Projekt forrasok létrehozasa (6)

« QOsszetett feladatok esetén a terv részleteit 6nallé

modulokba érdemes elhelyezni
* A modulok legyenek onallo fajlok

* A részekre osztas (particionalas) finomsaga (az
egyes modulok komplexitasa) egyéni dontés kérdése

* A lényeg, hogy segitse a terv megértését

* Sok esetben hasznalhatunk mar meglévo, konyvtari
modulokat. Ezek vagy csak olvashatok, vagy ha
nem, akkor csak a masolatukat adjuk hozza a
projekthez.

e Léteznek paraméterezheto modulok is (Iasd késobb)

BME-MIT
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Projekt forrasok létrehozasa (7)

» A Kkiilso jelek bekotésének megadasa (.UCF)
— Projekt — Add Copy of Source ...

— Jobb gomb, és — Add Copy of Source ...

BME-MIT

. Add Copy of Source

€I

Rendezés v Uj mappa

« Helyi lemez (D:) » DTLab »

Legutébbi helyek « Név
[ Felvett tévémisc

Labl
& OneDrive
Lab2
. . Lab3
s Konyvtara Labd
< Dokumentumok
— Lab5
B Kpe LOGSYS_SP3E
B videok =
@' Zene

+J Otthoni csoport

1M Szamitégép
&, Helyilemez (C)

ca Helyilemez(D:) « «

Fajinév: LOGSYS_SP3E

v |Sources( *.txt *.vhd *.vhdl *.v *.h

=]

i Megnyitas ‘ [ Mégse

IW

View: @ 1 Implementation ) 5 Simulation

rr:l Hierarchy
& ] Labl
Z e 0 x3s250e-4tq1ad
([ Labl 1 (DA\DTLab\Labl\Labl 1.v)
&l
a N
2
m A
Opei
&| Rem
» | 80 NoProcesses Running Manual Compile Order
£ | Processes : Labl 1 Set as Top Module
£| £ Design Summary/Reports  SmanGuide...
5 % Design Utilities
1| @ g User Constraints P Impiement Top Module
—|® 8 Synthesize - xST "
58  Implement Design File/Path Display
(} Generate Programming Fi Expand Al
4 1%  Configure Target Device
€ Analyze Design Using Chij__ ColPse Al
) Eind... Curl+F
(A Design Properties...
rce Propesties...

| Ga
Fies | Y S

& Start | B3 pesign |
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Projekt forrasok létrehozasa (8)
* A proj ektstruktura elkésziilt

- IE S
B -
L) 2 % I X|va| 2 2LARARIR EEI[LRPEL
E; 1
P
| €2 Noprocesses Rum -
£ Proces:
| @ @  User Constraints
4
mmmmmmmmm 5]
BM]‘:L.I ccccc qrsr/w‘ 108 Fndin Fles Results
FPGA labor

Projekt forrasok létrehozasa (9)

A kilso jelek bekotésének specifikacioja

— A LOGSYS_ SP3E.UCF {f4jlt a projektkonyvtarba masoltuk
es a hasznalando jeleket aktivaljuk ( a proj ektre szabJuk )

ENET Loc

L]

(LU LI | I I I}
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Projekt terv megvalositasa (1)

A tervezési feladat alapjan megirjuk a ,,Top Module”
és az esetleges egyéb modulok funcionalitasat
realizalo kodrészleteket

— Lasd pl. Labl 1.v 1, 2, 3 feladatok
* Mentés, szintaktikai ellenorzések, javitasok
« Ha minden rendben, akkor
— Az elvi (funkcionalis) terv ellenOrzése szimulacioval

— A terv realizalasa €s a generalt konfiguraci6 letoltése
a kartyara, ¢s tesztelése a miikodd hardveren

BME-MIT /\/\A
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P¢lda: Labl 1 tervezesi feladatok

A létrehozott Lab1l 1.v Verilog HDL modul iires
vazaba készitjiik el az elso tervspecifikaciot

‘timescale 1lns / 1ps
////////////////////////////////////////////////////////////////////////////////////
//////////////////////////////////////////////////////////////////////////////////
/ / T «.—\«A.o—-ﬂ

// Digitalis Technika Laboratérium 1. hét

// 1. bemutatd prijekt: A k6rnyezet hasznalatanak bemutatasa

/

// LED-ek vezérlése DIP kapcsoldkkal

// Részfeladatok:

// 1 1 1 Egys__A1 vezetékezés, mlveletvégzés nélkill, 8 bites vektor jelekkel

// 1.1 2 Kettes komplemens képzés

// 1 1 3 Aritme tl} al mive l~“£ vizsgalata (+, *, /, %, **) 4 bites operandusokon

//////////////////////////////////////////////////////////////////////////////////////////////

module Labl 1(
input [7:0] sw,
output [7:0] 1d
)

// IDE IRANDO A VERILOG KOD

endmodule

BME-MIT /\/\A
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A terv ellenorzése szimulacioval

* A szimulator egy szamitogépes program, amely a
terv logikai miikodését ellenorzi

* Funkcionalis szimulacional csak a modulok
bemeneti — kimeneti 0sszefiiggéseit szimulalja, a
valos fizikai hatasokat, a végleges terv valodi belso
paramétereit (idozités, terhelés) nem kezeli

« A szimulator egy tesztkornyezetet ad, amelyben
a bemeneteket jelforrasokkal, ..generatorokkal”
vezéreljuk és vizsgaljuk ,,monitorozzuk” a
kimenetek allapotat (mintha valéban miikodtetnénk)

BME-MIT /\N
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A szimulaci0s kornyezet

« A Xilinx ISE beépitett szimulatora az ISim
— Verilog ¢s VHDL tervek funkcidjat szimulalja
— Qyari alkatrészmodell konyvtarakat hasznal

* A tesztkornyezet neve Verilog Test Fixture

— Specialis modul, nincsenek bemenetei/kimenetei,
azaz minden beliil van, ami a szimulacidhoz kell

— Persze mindent nekiink kell beletenni, mert
kezdetben iires

— Specifikaljuk a meghajto jeleket, tesztvektorokat,
gondoskodunk az alaphelyzetbe allitasrol és a
kimeneti eredmeények kiertékelesi modjarol.

BME-MIT /\/\A
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A szimulaci0s kornyezet

* A tesztkornyezet hierarchia felépitése
— Szimulacids kornyezet = (Verilog Test Fixture)
— A beagyazott Verilog module, a tesztelt tervfajl
azonositoja UUT, ,,Unit Under Test”

» Ez egy 4ltalanos azonosito a tesztkornyezetbe beillesztett
tetszoleges tervezesi fajlra (pl. Labl 1.v)
— Megjegyzés: A szimulacios kornyezet felépitése
altalaban Osszetettebb munka, mint a terv{ajl
elkészitése. Sokan nem is szeretik ezt a feladatot.

— De ellendrzés nélkiil a terv ritkan miitkodik helyesen!
Ez jellemzden minden teriileten 1gaz!

BME-MIT /\/\A
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A szimulaci0 elokészitése

* A projekt nézetet atvaltjuk szimulacios modba

w08 X

* View — Simulation

© 38 Simuation
<] |Behavioral v]

— Hatas: UCF nem lathato ==

— Alul Process ablak , kiiiriil” - qjub

— Csak a legfelso szintii (jelen - B A Corpot e
esetben egyetlen) Labl 1.v S
tervfajl marad lathato ”_’“m ] o

— Ehhez rendeljiik hozza - e
1) forrasként a teszt-
kornyezetet
(az ismert modokon...) = ] %2 e [6 [0

BME-MIT /\/\A
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A szimulaci0 elokészitése

« Az uj forras tipusa Verilog Test Fixture

— Neve legyen a terv- =
hez kapcsolodd, TF o
- Select Source Type
kle ge S thé S Sel . Pl . .e;;::r::;vpe, ﬁle‘ rame andits \ocau‘on, v
Lab 1_ 1 _TF vV @
[©] Schemati
. . [2] User Document t
—_— [v] Verilog Modul File name:
Ez1s egy Verilog HDL | fizzzc. e
fajl, csak a hasznalata J ores =
specialis
— Csak az ellenOrzés soran
rqe [ moremnfo | Next | [ concel
hasznaljuk
BME-MIT
/\/\A FPGA labor
° 14 L 4 rr r 14 14
A szimulaci0 elokészitése
* A Verilog Test Fixture mintafajl generalasa a
tesztelendo fajl (UUT) interfészjellemzoitol (a
bemeneti és a kimeneti jelektol) fiigg, ezért meg
kell adni a fajlt.
— A peldaban csak egy fajlf, =
van, ezert ez egyertelma | =
— Osszetettebb projektnél
kivalaszthato, mi legyen
a teszt celpontja
MMMMM o | ([ vet ][ conce ]
BME-MIT
/\/\A FPGA labor




A szimulaci0 elokészitése

* A létrehozott Labl 1 TF a szimulacios lizemmod
beagyazo kornyezetét biztositja

* Vezeérli a bemeneteket, megfigyeli a kimeneteket
« Beépiti a Labl 1.v tervet, mint UUT

 Inicializalja a valtozokat, és futtat 100ns ideju
szimulaciot

« Ezutan varja a sajat
tesztvektorok, teszt-
eloirasok megadasat ...._..

eeeeeeeeeeeeeeeeeeeeeeeeeeeeeeee

az initial begin end -

blokkon beliil
BME-MIT /\N
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A szimulaci10 inditasa

* A szimulacio inditasa a Labl 1 TF.v Verilog Test
Fixture fajl kivalasztasaval és a Process ablakban a
Simulate Behavioral Model parancs kiadasaval

r Design 08 x
le h et S e g e S i View: @ Implementation © @ Simulation
&l

(& [Behavioral [+]

A Hierarchy

oo r /4 = (=
* Ekkor egy onallo program, az | 5.s

[ Labl_1_TF (D:\DTLab\Labl\Labl 1_TF.v)
&l uut - Labl _1 (D:\DTLab\Lab1\Lab1_1.v)

ISim szimulator indul el

Kz beolvassa a forrasokat és
szintaktikai ellenorzés utan ry—

74; | Processes : Labl 1_TF
{2 @  ISimSimulator

a szimulacios projekt futathato bim ek
modelljét generalja, amit az =~
ISim GUI-ban tesztelhetiink

BME-MIT /\/v\ & Strt| @3 Desgn | ] Fies | () Lbraries

Be
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A Xilinx ISim szimulator

* A szimulator egy osszetett program kornyezet

— Legfontosabb részlete a hullamforma ablak, ahol az
1d0 fuiggvényében latjuk, hogy a bemeneti vezérlésre

hogyan reagél S —
atesztelt UUT. mme hyy — mem—m—pmme
— Altalaban ”“
programozott
tesztekkel
dolgozunk
— De ehhez kell — R
a Verilog nyelv=
BME-MI Ti/S\NIIl?I'G'[G EXL T € 1 0] ]| A ]
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Az ISim hasznalata

« A HDL alapu tesztelés a programozott tesztvektor
generalassal hasznalhato

cale 1ns / 1ps

— A Test Fixture fajlban eléirjuk ‘e oo

a teszt 1dobeli lefutasat. res (01 0
— Az 1initial begin  end egyfajta e
litemezett lefutast biztosit, azaz
100ns litemezéssel (‘timescale) ...
kiadja/aktivalja/végrehajtja we

az 1) tesztvektorokat, majd leall

* A Test Fixture ujraforditas e nlt
utan hasznalhato az Isim

ujrainditasaval vagy relaunch
BME-MIT
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Labl 1 1 feladat

* A szimulacio befejezése utan generaljuk a
specifikaciohoz tartozo konfiguracios adatfajlt

Design

- Im‘zle}utéciés mdd (NEM SZIMULACIOS!)

View: ©@ Simulation

& I Hierarchy

— A Labl 1.v tervezoi fajl aktiv (+ az UCF 1s)

Design
B View: @ Ii:a}[mplementaﬁon € @Simulanon
@

Hierarchy
15 Labl
E Ed xc3s250e-5tqldd
58 " Labl 1 (D:\Xilinx\Projects\DTLab\Labl\Labl_1.v)
g D:\Xilinx\Projects\DTLab\Lab1\LOGSYS_SP3E.ucf

— Konfiguracios fajl generalas

Processes: Labl 1

Design Summary/Reports
Design Utilities

User Constraints

Synthesize - XST

Implement Design

Generate Programming File
Configure Target Device

Analyze Design Using ChipScope

BME-MIT /\/v\
i FPGA labor

- -
- ety gl

)
PER

Az FPGA felkonfiguralasa

* Inditsuk el a LOGSYS alkalmazast Hi
m--
« Csatlakoztassuk a fejlesztoi kabelt a Logsys
szamitogéphez és az FPGA kartyahoz
« Kapcsoljukbea | =" ~ N
+5V tapfesziiltséget, == — :
ellendrizziik a mért | = ="
adatokat:
— Vo SV,

— V,.1/0:3,3V;
— V. JTAG: 2,5V;
— I, kb. S0mA

out*

BME-MIT /\/v\
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Az FPGA felkonfiguralasa

Nyissuk meg a JTAG Download konfiguracios interfészt
Azonositsuk az elérheto eszkozoket— Query JTAG Chain
Valasszuk ki az FPGA-t a listabol (csak egy eszkoz van)
Toltsiik le az FPGA-ra a projekt konyvtarbol a

lab1_1.bit fajlt
(Configure...)

A zold szini
DONE LED
kigyulladasa
jelzi a sikeres
konfiguralast

Teszteljiik a
miukodést!

Yoref: 3,29 V Critical Value: 90 2] %

JTAGref: 2,48 V Samples/Second: 10 |5

1" Programmi

g device
ycle = NoWa.
W

doe.
LCK_cycle

LCK cycle: NoWait
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